
1 
 

คู่มือการใช้ Meta Trader 4 

ฟอเร็กซ์ (Forex) คืออะไร 
Forex (Foreign Exchange Market) หรือเรียกสั้นๆวา่ FX เป็นตลาดในการซ้ือขายอตัราแลกเปล่ียนของสกุลเงิน
ต่างๆ ซ่ึง Forex เป็นตลาดท่ีมีการซ้ือขายมากท่ีสุดในโลกกวา่ 4 แสนลา้นเหรียญสหรัฐต่อวนัซ่ึงมากกวา่ตลาด
หุน้ทั้งโลกมารวมกนั ตลาด Forex เปิดท าการตั้งแต่วนัจนัทร์ถึงศุกร์ตลอด 24 ชัว่โมงและหยดุการซ้ือขายในวนั
เสาร์อาทิตย ์ตลาดใหญ่ๆของโลกจะมีอยู ่3 แห่งก็คือ ตลาดโตเกียว ตลาดลอนดอน และตลาดนิวยอร์ค ซ่ึงเวลา
ท าการเม่ือเทียบกบัเวลาประเทศไทยก็จะเป็นดงัน้ี (ถา้อยูใ่นช่วงฤดูหนาวก็ใหเ้พิ่มอีก 1 ชัว่โมง) 
 
ตลาดออสเตรเลีย (AUD) เวลา 5:00 – 13:00 
ตลาดญ่ีปุ่น (JPY) เวลา 7:00 – 14:00 
ตลาดยโุรป (EUR) เวลา 13:00 – 21:00 
ตลาดสวสิ (CHF) เวลา 13:00 – 21:00 
ตลาดองักฤษ (GBP) เวลา 14:00 – 22:00 
ตลาดอเมริกา (USD) เวลา 19.00 - 3:00 
 
สกุลเงิน 
สกุลเงินหลกัๆท่ีท าการซ้ือขายนั้นก็จะมีอยู ่7 สกุลเงินดว้ยกนัก็คือ ดอลลาร์สหรัฐอเมริกา (USD) ยโูร (EUR) 
ปอนด ์(GBP) เยน (JPY) ดอลลาร์แคนาดา (CAD) สวสิฟรังค ์(CHF) และดอลลาร์ออสเตรเลีย (AUD) 
 
การซ้ือขายสกุลเงินในตลาด Forex นั้นจะท ากนัเป็นคู่ๆ (Currency Pair) ซ่ึงคู่ของสกุลเงินหลกัหรือท่ีเรียกวา่ 
Major นั้น จะมีอยู ่4 สกุลดว้ยกนัคือ GBP/USD, EUR/USD, USD/CHF, USD/JPY ซ่ึงสกุลเงินท่ีอยูข่า้งหนา้จะ
เรียกวา่ Base Currency และตวัหลงัเรียกวา่ Counter Currency เช่นคู่ GBP/USD ก็จะมี GBP เป็น Base Currency 
และ USD เป็น Counter Currency ส่วนความหมายนั้นก็ใหจ้  าง่ายๆวา่ตวั Base Currency จะมีค่าเป็น 1 เสมอ 
สมมติวา่ราคาของคู่ GBP/USD เป็น 1.5000 ก็จะหมายความวา่ 1 ปอนดมี์ค่าเท่ากบั 1.5 ดอลลาร์ 
 
Pip 
Pip คือจ านวนจุดท่ีนอ้ยท่ีสุดของคู่เงินนั้นๆ ตวัอยา่งเช่นราคาของคู่  GBP/USD จะมีทศนิยม 4 จุด เช่น 1.5000 
เพราะฉะนั้น 1 pip ก็จะมีค่าเท่ากบั 0.0001 ส่วนราคาของคู่ท่ีมีสกุลเงินเยนอยูจ่ะมีทศนิยม 2 จุด เช่นราคาของคู่ 
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USD/JPY เป็น 110.00 ดงันั้น 1 pip ของคู่น้ีก็จะมีค่าเท่ากบั 0.01 
 
Lot 
ขนาดของสัญญาท่ีจะท าการซ้ือขายกนันั้นเรียกวา่ lot ซ่ึงเป็นตวัก าหนดวา่แต่ละ pip ท่ีเราเปิดออเดอร์นั้นจะมีค่า
เป็นก่ีดอลลาร์ ซ่ึงขนาดของสัญญาก็จะมี 3 ประเภทคือ Standard lot, Mini lot และ Micro lot ซ่ึง 1 standard lot 
จะเท่ากบั 10 mini lot และ 1 mini lot จะเท่ากบั 10 micro lot ถา้จะเทียบเป็นดอลลาร์ก็จะไดค้ร่าวๆวา่ 
 
ท่ี 1 standard lot ทุกๆ 1 pip จะมีค่าเท่ากบั $10 
ท่ี 1 mini lot ทุกๆ 1 pip จะมีค่าเท่ากบั $1 
ท่ี 1 micro lot ทุกๆ 1 pip จะมีค่าเท่ากบั $0.1 
 
ถา้เทียบกบับญัชีของ FXClearing ก็จะมีค่าดงัน้ี 
บญัชีไมโคร ถา้เปิดออเดอร์ท่ี 10 lot ทุกๆ 1 pip จะมีค่าเท่ากบั $1 
บญัชีมินิ, ECN ถา้เปิดออเดอร์ท่ี 0.1 lot ทุกๆ 1 pip (ทศนิยมจุดท่ี 4) จะมีค่าเท่ากบั $1 
บญัชีนาโน ถา้เปิดออเดอร์ท่ี 100 lot ทุกๆ 1 pip จะมีค่าเท่ากบั $1 
 
Spread 
Spread คือผลต่างของราคา Bid และ ราคา Ask หน่วยเป็นจ านวนจุด ซ่ึงราคา Ask ก็คือราคาท่ีเราจะท าการซ้ือ
และราคา Bid ก็คือราคาท่ีเราจะท าการขาย ซ่ึงราคา Bid จะนอ้ยกวา่ราคา Ask เสมอ ตวัอยา่งเช่นคู่ EUR/USD มี
ราคา Bid เป็น 1.5540 ราคา Ask เป็น 1.5541 ดงันั้น Spread จะมีค่าเท่ากบั 1 จุด ซ่ึง Spread ก็เปรียบเสมือนกบั
ค่าธรรมเนียมของโบรกเกอร์ท่ีคิดกบัเรานัน่เอง ยิง่มีค่านอ้ยยิง่ดี 
 
Margin 
Margin เปรียบเสมือนกบัค่ามดัจ าท่ีเราตอ้งใชใ้นการเปิด Order แต่ละคร้ัง และก็จะเพิ่มกลบัเขา้ไปในบญัชี
เหมือนเดิมเม่ือท าการปิดออเดอร์ ยิง่ใส่จ  านวน Lot ในการเปิดออเดอร์มากเท่าไหร่ จ  านวน Margin ท่ีใชก้็จะยิง่
เพิ่มมากข้ึน 
 
Leverage 
Leverage จะเป็นตวัก าหนด Margin ท่ีเราใชใ้นการเปิดออเดอร์แต่ละคร้ัง Leverage โดยปกติจะมีใหเ้ลือกตั้งแต่ 
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1:100 จนถึง 1:500 ยิง่ Leverage มาก จ านวน Margin ท่ีใชก้็จะนอ้ยลง ส าหรับจ านวน Margin ท่ีตอ้งใชก้็คิด
ง่ายๆก็คือท่ี Leverage 1:500 ถา้เราเทรดท่ี 0.1 lot (1 pip เท่ากบั $1) จะใช ้Margin ประมาณ $20-$30 ถา้เป็น 
Leverage 1:100 ก็จะใช ้Margin เท่ากบั $100 - $150 ($20*5 - $30*5) ซ่ึงค่า Margin ท่ีใชก้็จะเปล่ียนแปลงไปได้
ตามราคาของสกุลเงิน สามารถค านวณ Margin ท่ีใชข้องคู่สกุลเงินต่างๆไดท่ี้ 
http://www.forexrazor.com/Tools/Resources/Forex-Margin-Calculator.aspx 
 
Swap 
Swap คือดอกเบ้ียท่ีเราจะไดห้รือเสียไปเม่ือเราท าการเปิดออเดอร์ทิ้งไวข้า้มคืน (ขา้มช่วงเวลาเท่ียงคืนตามเวลา 
Server ในโปรแกรม MT4) ค่า Swap ของแต่ละสกุลเงินสามารถเขา้ไปดูไดท่ี้ MT 4 -> หนา้ต่าง Market Watch -
> คลิกขวา เลือก Symbols -> เลือกสกุลเงินท่ีตอ้งการ -> กดปุ่ม Properties จะแสดงค่า Swap Long (ค่า Swap 
ส าหรับออเดอร์ซ้ือ) และ Swap Short (ค่า Swap ส าหรับออเดอร์ขาย) มีหน่วยเป็น pip คืนวนัเสาร์และอาทิตยไ์ม่
มีการคิดค่า Swap แต่จะไปทบในคืนวนัพุธแทนซ่ึงค่า Swap คืนวนัพุธจะมีค่าเป็น 3 เท่าของค่า Swap ปกติ 
ส าหรับ FXClearing ทุกบญัชีจะไม่คิดค่า Swap ยกเวน้บญัชี ECN 
 
การวเิคราะห์ 
ส าหรับการวเิคราะห์การเทรดก็จะแบ่งเป็น 2 ส่วนหลกัๆคือ ปัจจยัพื้นฐาน (Fundamental Analysis) และปัจจยั
ทางเทคนิค (Technical Analysis) 
 
การวเิคราะห์ปัจจยัพื้นฐานก็คือการวเิคราะห์ข่าวต่างๆท่ีเกิดข้ึน ท่ีเวบ็ไซต์ http://www.forexfactory.com ก็จะมี
การอพัเดทข่าวต่างๆท่ีเก่ียวกบั Forex อยูต่ลอดเวลาซ่ึงก็จะมีล าดบัความส าคญัของข่าวดว้ย ยิง่เป็นข่าวท่ีมี
ความส าคญัมากก็จะมีผลกระทบกบัราคาไดม้าก 
 
การวเิคราะห์ปัจจยัทางเทคนิคก็จะเป็นการวเิคราะห์จากรูปแบบของกราฟเป็นหลกั โดยดูจากรูปแบบของกราฟ
วา่มีแนวโนม้เป็นอยา่งไร แนวรับแนวตา้นอยูต่รงไหน และมีการใชอิ้นดิเคเตอร์ต่างๆมาช่วยในการวเิคราะห์ดว้ย 
เช่น Moving Average, Fibonacci, RSI ซ่ึงอินดิเคเตอร์พื้นฐานท่ีใชโ้ดยทัว่ไปก็จะมีใหเ้ลือกใชใ้นโปรแกรมเทรด 
 
ตัวอย่างการซ้ือขาย 1 
สมมติท่ีคู่ GBP/USD มีราคาปัจจุบนัเป็น 1.5000 ก็จะหมายความวา่ 1 ปอนดมี์ค่าเท่ากบั 1.5 ดอลลาร์ ถา้เราคิดวา่
ในอนาคต 1 ปอนดจ์ะมีค่ามากกวา่ 1.5 ดอลลาร์ ก็ใหเ้ราท าการเปิดออเดอร์ซ้ือ ถา้ในอนาคตราคาท่ีคู่น้ีเป็น 

http://www.forexrazor.com/Tools/Resources/Forex-Margin-Calculator.aspx
http://www.forexfactory.com/
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1.5010 แลว้เราท าการปิดออเดอร์น้ี เราก็จะไดก้ าไรมา 10 จุด ถา้เราใส่ Volume เป็น 0.1 lot ตอนเปิดออเดอร์ (แต่
ละจุดเท่ากบั $1) ก าไร 10 จุดก็จะเท่ากบั $10 แต่ถา้ราคาตกลงมาเป็น 1.4990 เราก็จะขาดทุน $10 
 
ตรงกนัขา้ม ถา้เราคิดวา่ในอนาคต 1 ปอนดจ์ะมีค่านอ้ยกวา่ 1.5 ดอลลาร์ ก็ใหเ้ราท าการเปิดออเดอร์ขาย (สามารถ
เปิดออเดอร์ขายไดเ้ลยโดยไม่จ  าเป็นตอ้งเปิดออเดอร์ซ้ือก่อน) ถา้ในอนาคตราคาท่ีคู่น้ีเป็น 1.4990 แลว้เราท าการ
ปิดออเดอร์น้ี เราก็จะไดก้ าไรมา 10 จุด ถา้เราใส่ Volume เป็น 0.1 lot ตอนเปิดออเดอร์ (แต่ละจุดเท่ากบั $1) 
ก าไร 10 จุดก็จะเท่ากบั $10 แต่ถา้ราคาข้ึนมาเป็น 1.5010 เราก็จะขาดทุน $10 
 
ตัวอย่างการซ้ือขาย 2 

 
จากรูปเป็นรายละเอียดออเดอร์ท่ีท าการเปิดข้ึนในโปรแกรม MT4 (มีคู่มือการใชใ้หด้า้นล่าง) บญัชีน้ีเป็นบญัชีมินิ 
ออเดอร์น้ีเป็นออเดอร์ขาย (Type เป็น Sell) ของคู่สกุลเงิน AUD/USD เปิดท่ี 0.10 lot (1 pip = $1) ท่ีราคา 1.0387 
ซ่ึงราคาปัจจุบนัเป็น 1.0351 ซ่ึงนอ้ยกวา่ราคาท่ีเราเปิดขายอยู ่36 pip เน่ืองจากออเดอร์น้ีเป็นออเดอร์ขาย ดงันั้น
เราก็มีก าไรตอนน้ีอยู ่$36 (1 pip = $1 จากท่ีเราเปิด 0.10 lot ถา้เราเปิดเป็น 1 lot เราก็จะไดก้ าไร $360) สมมติถา้
ออเดอร์น้ีเป็นออเดอร์ซ้ือ (Buy) เราก็จะขาดทุนอยู ่$36 
 
MetaTrader 4 (MT4) 
MT4 เป็นโปรแกรมใชส้ าหรับการเทรดซ่ึงโบรกเกอร์โดยส่วนใหญ่ก็จะรองรับ MT4 รายละเอียดเพิ่มเติม
สามารถเขา้ไปดูไดท่ี้ http://www.metaquotes.net/en/metatrader4/trading_terminal  

 
Expert Advisor (EA) 
เป็นโปรแกรมท่ีเขียนข้ึนมาใน MetaEditor (เปิดไดโ้ดยกด F4 ท่ี MT4) ท่ีเขียนข้ึนมาเพื่อให ้MT4 ท าการซ้ือขาย
ตามเง่ือนไขท่ีเราเขียนไวใ้นโปรแกรมใหอ้ตัโนมติั  ซ่ึงจะเป็นการช่วยใหเ้ราไม่ตอ้งเฝ้าหนา้จออยูต่ลอดเวลา 
 
Scalping คืออะไร 
เขา้ไปอ่านบทความไดท่ี้ https://www.facebook.com/note.php?note_id=229249743757310 

http://www.metaquotes.net/en/metatrader4/trading_terminal
https://www.facebook.com/note.php?note_id=229249743757310
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Hedge คืออะไร 
การเทรดแบบ Hedge คือการเปิดออเดอร์ทั้งซ้ือและขายท่ีสกุลเงินเดียวกนัเวลาเดียวกนั 
 
Requote คืออะไร 
เขา้ไปอ่านบทความไดท่ี้ https://www.facebook.com/note.php?note_id=220162991332652 
 

การเทรดผ่านโทรศัพท์มือถือหรือแทบ็เลต็  
สามารถเทรดผา่นโทรศพัท ์iPhone, Android หรือ Blackberry ไดฟ้รี รายละเอียดเขา้ไปดูไดท่ี้   

http://www.ironfx.com 

VPS คืออะไร 
VPS คือ เคร่ือง Server ท่ีเราสามารถเอาไวใ้ชเ้ทรดหรือรัน EA โดยท่ีไม่ตอ้งเปิดเคร่ืองคอมพิวเตอร์ของเราไว้
ตลอด 24 ชัว่โมง ซ่ึงก็จะเป็นการป้องกนัการไฟดบัหรืออินเตอร์เนตหลุดในกรณีท่ีเราเทรดหรือรัน  EA ท่ีเคร่ือง
คอมพิวเตอร์ของเราเอง นอกจากน้ียงัช่วยในการเทรดผา่นโทรศพัทมื์อถือหรือแทบ็เล็ตต่างๆดว้ย 
 

โปรแกรม MT4 

สามารถเขา้ไปดาวน์โหลดโปรแกรมได้  https://www.ironfx.com/downloads/platforms/mt4/ironfx4setup.exe 

 การ Log in 

1) คลิกท่ีเมนู File -> Log in ดงัรูป 

https://www.facebook.com/note.php?note_id=220162991332652
http://www.ironfx.com/
https://www.ironfx.com/downloads/platforms/mt4/ironfx4setup.exe
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2) ใส่หมายเลขบญัชีและรหสัผา่นลงไป ตรงช่อง Server  

 

  

3) ถา้ Log in ผา่นเรียบร้อยแลว้ ตรงมุมล่างขวาจะแสดงเคร่ืองหมายดงัรูป ถา้ Log in ไม่ผา่นจะแสดงค าวา่ No 
Connection หรือ Invalid Account หรือขอ้ความ Error อ่ืนๆ 
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การเปลีย่นรหัสผ่าน 

1) เขา้ไปท่ีเมนู Tools -> Options 

 

  

2) คลิกท่ีแทบ็ Server และกดปุ่ม Change 
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3) ท่ีช่อง Current password ใหใ้ส่รหสัผา่นปัจจุบนั, ช่อง New password ใส่รหสัผา่นท่ีตอ้งการเปล่ียน (รหสัผา่น
จะตอ้งมีความยาวอยา่งนอ้ย 5 ตวั และ 2 ใน 3 จะตอ้งมีตวัอกัษรตวัเล็ก, ตวัใหญ่, และตวัเลขรวมอยูด่ว้ย), ช่อง 
Confirm ใส่รหสัผา่นใหม่ยนืยนัอีกคร้ัง เสร็จแลว้กด OK 

 

  

การเปิดกราฟ 

1) กดเคร่ืองหมายบวกท่ีอยูด่า้นบนซา้ยและเลือกสกุลเงินท่ีตอ้งการ 
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ถา้ไม่เจอคู่เงินท่ีตอ้งการ ใหเ้ขา้ไปคลิกขวาท่ีหนา้ต่าง Market Watch และเลือกท่ี Show All 
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2) กราฟของสกุลเงินจะแสดงข้ึนมาดงัรูป เวลาในกราฟจะเป็นเวลาท่ี Server ของ Ifonfx 

 

  

3) สามารถปรับแต่งรูปแบบของกราฟ เช่น สี, ประเภทของกราฟ, เส้นต่างๆ โดยคลิกขวาท่ีกราฟและเลือก 
Properties หรือกด F8 
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4) ท่ีแทบ็ Colors สามารถเปล่ียนสีของกราฟได ้
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5) ท่ีแทบ็ Common สามารถเปล่ียนรูปแบบของกราฟรวมถึงใหแ้สดงหรือซ่อนเส้นต่างๆได้ 
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Toolbar 

ท่ี Toolbar ก็จะมีไอคอนต่างๆใหใ้ชง้านดงัน้ี (เรียงล าดบัตามกรอบสีแดงท่ีวงไวจ้ากบนลงล่าง) 

  

 

  

1) ใหแ้สดงหรือซ่อนหนา้ต่างดงัน้ี 

1.1) Market Watch - หนา้ต่างดูราคาของสกุลเงินคู่ต่างๆแบบเรียลไทม์ 
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1.2) Data Window - หนา้ต่างดูขอ้มูลราคาเปิด, ปิด, สูงสุด, ต ่าสุด, Volume ของกราฟ ใหน้ าเมาส์ไปวางไวท่ี้
ต าแหน่งท่ีตอ้งการดูรายละเอียดในกราฟ 

 

  

1.3) Navigator - หนา้ต่างแสดงรายช่ือ, Indicator, EA, Script 
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1.4) Terminal - หนา้ต่างแสดงออเดอร์ท่ีก าลงัเปิดอยู่, ประวติัการเทรด, Mailbox, Log ของ EA, รายละเอียดการ 
Log in รวมถึง Error ต่างๆ 

 

  

1.5) Strategy Tester - หนา้ต่างไวส้ าหรับการเทส EA 

 

  

2) ปุ่มเปิดออเดอร์ซ้ือขาย 

3) ปุ่มเปิด MetaEditor (ใชเ้ขียน EA) และปุ่มเปิด/ปิดการใชง้าน EA 

4) ปุ่มแสดงรูปแบบกราฟเป็นแบบแท่ง, แท่งเทียน, เส้น 

5) ปุ่มยอ่/ขยายกราฟ 

6) ปุ่ม Auto Scroll ใหก้ราฟขยบัไปทางซา้ยเร่ือยๆเม่ือราคามีการอพัเดท และปุ่ม Chart Shift คือใหก้ราฟขยบั
เล่ือนไปทางดา้นซา้ย 
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7) ปุ่ม Indicator ไวเ้พิ่ม Indicator ในกราฟ, ปุ่ม Period ไวเ้ลือกช่วงเวลา (Timeframe) ต่างๆ, ปุ่ม Templates ไว้
เซฟรูปแบบกราฟเก็บไว ้

8) ปุ่มเลือกรูปแบบเมาส์เป็น Cursor หรือ Crosshair เพื่อแสดงในกราฟ 

9) เอาไวล้ากเส้น, เขียนขอ้ความต่างๆบนกราฟ, และ Indicator Fibonacci 

10) เลือกช่วงเวลา (Timeframe) ต่างๆ 

  

การเพิม่ Indicator 

1) คลิกท่ีปุ่ม Indicators ทางดา้นบนและเลือก Indicator ท่ีตอ้งการเพิ่ม 

 

  

2) เสร็จแลว้จะมีหนา้ต่างเพื่อเซตค่าต่างๆส าหรับ Indicator ตวัอยา่งแสดงการเพิ่ม Moving Average 
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3) Indicator ก็จะแสดงในกราฟดงัรูป 

 

  

4) ถา้ตอ้งการแกค้่าต่างๆของ Indicator ใหด้บัเบิ้ลคลิกท่ี Indicator ก็จะมีหนา้ต่างเซตค่าต่างๆแสดงข้ึนมาเหมือน
ในขอ้ท่ี 2 

  

5) ถา้ตอ้งการลบ ใหก้ด Ctrl + i จะแสดงรายช่ือ Indicator ทั้งหมดท่ีอยูใ่นกราฟ ใหค้ลิกช่ือ Indicator ท่ีตอ้งการ
ลบ แลว้กด Delete 
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6) สามารถลง Indicator อ่ืนๆเพิ่มเติมไดโ้ดยใหเ้ขา้ไปท่ีเมนู File -> Open data folder แลว้น าไฟล ์
Indicator (ไฟลน์ามสกุล mq4 หรือ ex4)  ใส่ไวท่ี้โฟลเดอร์ MQL4 -> Indicators เสร็จแลว้ Restart MT4, ท าตาม
ขอ้ 1 ก็จะเห็นช่ือ Indicator ท่ีเพิ่มไวอ้ยูใ่นหวัขอ้ Custom 

  

การเปิด/ปิดออเดอร์ 

1) กดปุ่ม New Order บน Toolbar หรือกดปุ่ม F9 (ถา้ท่าน Log in โดยใช ้Investor Password ท่านจะไม่สามารถ
กดปุ่มน้ีได,้ Investor Password จะใชส้ าหรับใหค้นอ่ืนดูผลการเทรดเท่านั้น ไม่สามารถท าการเทรดได้) 

 

  

2) จะมีหนา้ต่างแสดงข้ึนมาดงัรูป 
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2.1) Symbol - คู่สกุลเงินท่ีตอ้งการซ้ือขาย 

2.2) Volume - จ  านวน Lot ท่ีตอ้งการเทรด 

2.3) Stop Loss - ราคาท่ีจะใหปิ้ดออเดอร์อตัโนมติัเม่ือขาดทุน 

2.4) Take Profit - ราคาท่ีจะใหปิ้ดออเดอร์อตัโนมติัเม่ือก าไร 

2.5) Comment - สามารถใส่ Comment ส าหรับออเดอร์ท่ีจะเปิด 

2.6) Type - Instant Execution / Market Execution คือเปิดออเดอร์ทนัที, Pending Order คือเปิดออเดอร์แบบ 
Pending (รอใหร้าคามาถึงจุดท่ีเราตอ้งการถึงจะท าการเปิดออเดอร์) 

2.7) Sell - เปิดออเดอร์ขาย 

2.8) Buy - เปิดออเดอร์ซ้ือ 
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2.9) Enable maximum deviation from quoted price ใชเ้พื่อป้องกนัการเจอปัญหา Requote อ่านรายละเอียด
เพิ่มเติมไดท่ี้ https://www.facebook.com/note.php?note_id=220162991332652 

  

3) ถา้เลือกการเปิดออเดอร์เป็นแบบ Pending หนา้ต่างจะเปล่ียนเป็นดงัรูป การเปิดออเดอร์แบบนั้ เป็นการตั้งเปิด
ออเดอร์ทิ้งไวใ้นกรณีท่ีราคาท่ีเราตอ้ง การซ้ือหรือขายยงัไม่เกิดข้ึน เม่ือราคาปัจจุบนัมาถึงราคาท่ีเราตั้งไว ้ออ
เดอร์ก็จะเปิดใหอ้ตัโนมติั 

 

  

ในส่วน Pending Order จะมีค่าต่างๆใหเ้ลือกดงัน้ี 

3.1) Type - Buy Limit คือท าการซ้ือเม่ือราคาปัจจุบนัอยูสู่งกวา่ราคาท่ีเราจะซ้ือ, Sell Limit คือท าการขายเม่ือ
ราคาปัจจุบนัอยูต่  ่ากวา่ราคาท่ีเราจะขาย, Buy Stop คือท าการซ้ือเม่ือราคาปัจจุบนัอยูต่  ่ากวา่ราคาท่ีเราจะซ้ือ, Sell 
Stop คือท าการขายเม่ือราคาปัจจุบนัอยูสู่งกวา่ราคาท่ีเราจะขาย 

ตวัอยา่ง 

https://www.facebook.com/note.php?note_id=220162991332652
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สมมติราคาปัจจุบนัเป็น 1.0000 แลว้ตอ้งการซ้ือท่ี 0.9xxx ใหต้ั้งเป็น Buy Limit 

สมมติราคาปัจจุบนัเป็น 1.0000 แลว้ตอ้งการซ้ือท่ี 1.0xxx ใหต้ั้งเป็น Buy Stop 

สมมติราคาปัจจุบนัเป็น 1.0000 แลว้ตอ้งการขายท่ี 0.9xxx ใหต้ั้งเป็น Sell Stop 

สมมติราคาปัจจุบนัเป็น 1.0000 แลว้ตอ้งการขายท่ี 1.0xxx ใหต้ั้งเป็น Sell Limit 

  

3.2) at price - ใส่ราคาท่ีเราตอ้งการซ้ือขาย 

3.3) Place - ท าการเปิดออเดอร์ Pending 

3.4) Expiry - เวลาหมดอายขุองออเดอร์ในกรณีท่ียงัไม่มีการเปิดออเดอร์  

  

4) ถา้ท าการเปิดออเดอร์แลว้จะเห็นรายละเอียดออเดอร์ท่ีหนา้ต่าง Terminal ดา้นล่างดงัรูป 

 

  

4.1) Order - หมายเลขออเดอร์ 

4.2) Time - เวลาท่ีท าการเปิดออเดอร์ (เวลาใน Server) 

4.3) Type - ประเภทออเดอร์ (ซ้ือหรือขาย) 

4.4) Size - จ  านวน Volume (Lot) 



22 
 

4.5) Symbol - สกุลเงิน 

4.6) Price - ราคาท่ีท าการเปิดออเดอร์ 

4.7) S/L - ราคา Stop Loss (0 คือไม่ไดท้  าการเซต) 

4.8) T/P - ราคา Target Profit (0 คือไม่ไดท้  าการเซต) 

4.9) Price - ราคาปัจจุบนั 

4.10) Commission - ค่าคอมมิชชัน่ 

4.11) Swap - ค่า Swap 

4.12) Profit - ก าไร/ขาดทุน 

4.13) Balance - ยอดเงินท่ียงัไม่รวมก าไรหรือขาดทุนของออเดอร์ท่ีก าลงัเปิดอยู่  

4.14) Equity - ยอดเงินท่ีรวมก าไรหรือขาดทุนของออเดอร์ท่ีก าลงัเปิดอยู่  

4.15) Margin - จ  านวน Margin ทั้งหมดท่ีใชไ้ปในการเปิดออเดอร์ 

4.16) Free Margin - จ  านวน Margin ท่ีเหลือเพื่อไวส้ าหรับเปิดออเดอร์ 

4.17) Margin Level - มีค่าเท่ากบั Equity / Margin * 100 เป็นอตัราส่วนระหวา่ง Equity กบั Margin ยิง่เยอะยิง่ดี 
ถา้ลดเหลือนอ้ยต ่ากวา่ค่า Margin level ตรงออเดอร์จะเป็นสีแดงๆเตือนข้ึนมา ถา้ต ่ากวา่ Stop level ออเดอร์ก็จะ
ถูกปิดใหโ้ดยอตัโนมติั ซ่ึงแต่ละบญัชีก็จะมีระดบั Margin level และ Stop Level ท่ีแตกต่างกนั  

  

5) ถา้ตอ้งการปิดออเดอร์ ใหด้บัเบิ้ลคลิกท่ีรายละเอียดของออเดอร์ จะมีหนา้ต่างแสดงข้ึนมาดงัรูป เลือก Type 
เป็น Instant Execution และกดปุ่ม Close เพื่อปิดออเดอร์ 
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6) ถา้ตอ้งการแกไ้ขออเดอร์ เช่น Stop Loss หรือ Target Profit ใหด้บัเบิ้ลคลิกท่ีรายละเอียดของออเดอร์ จะมี
หนา้ต่างแสดงข้ึนมาดงัรูป เลือก Type เป็น Modify Order แกไ้ขรายละเอียดดามตอ้งการ และกดปุ่ม Modify เพื่อ
แกไ้ขออเดอร์ 
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7) ถา้ท าการปิดออเดอร์แลว้ รายละเอียดออเดอร์ก็จะยา้ยไปอยูใ่นแทบ็ Account History ดงัรูป 

 

  

7.1) Order - หมายเลขออเดอร์ 

7.2) Time - เวลาท่ีท าการเปิดออเดอร์ (เวลาใน Server) 

7.3) Type - ประเภทออเดอร์ (ซ้ือหรือขาย) 

7.4) Size - จ  านวน Volume (Lot) 
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7.5) Symbol - สกุลเงิน 

7.6) Price - ราคาท่ีท าการเปิดออเดอร์ 

7.7) S/L - ราคา Stop Loss (0 คือไม่ไดท้  าการเซต) 

7.8) T/P - ราคา Target Profit (0 คือไม่ไดท้  าการเซต) 

7.9) Time - เวลาท่ีท าการปิดออเดอร์ (เวลาใน Server) 

7.10) Price - ราคาท่ีท าการปิดออเดอร์ 

7.11) Commission - ค่าคอมมิชชัน่ 

7.12) Swap - ค่า Swap 

7.13) Profit - ก าไร/ขาดทุน 

  

8) ท่ีแทบ็ Account History สามารถคลิกขวาเพื่อเลือกออฟชัน่ต่างๆไดด้งัน้ี 
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8.1) All History - ใหแ้สดงประวติัการเทรดทั้งหมด (โดย Default จะแสดงประวติัการเทรดของเดือนปัจจุบนั) 

8.2) Last 3 Months - ใหแ้สดงประวติัการเทรดยอ้นหลงั 3 เดือน 

8.3) Last Month - ใหแ้สดงประวติัการเทรดของเดือนปัจจุบนั 

8.4) Custom Period - สามารถเลือกช่วงเวลาท่ีจะใหแ้สดงประวติัการเทรดได้ 

8.5) Save as Report - คือการ Export ประวติัการเทรดออกมาเป็นไฟล์ 

8.5) Save as Detailed Report - คือการ Export ประวติัการเทรดแบบละเอียดออกมาเป็นไฟล์ 

8.6) Commissions - ใหแ้สดง/ซ่อนคอลมัน์ Commissions 

8.7) Taxs - ใหแ้สดง/ซ่อนคอลมัน์ Taxs 

8.8) Comments - ใหแ้สดง/ซ่อนคอลมัน์ Comments 

8.9) Auto Arrange - จดัขนาดของคอลมัน์อตัโนมติั 

8.10) Grid - ใหแ้สดง/ซ่อนเส้นแบ่งคอลมัน์ 

  

9) ท่ีแทบ็ Journal จะแสดงรายละเอียดค าสั่งท่ีเราท าการเทรดทั้งหมด รวมถึง Error ต่างๆ 

 

  

การติดตั้งและรัน Expert Advisor (EA) 
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1) ใหเ้ขา้ไปท่ีเมนู File -> Open data folder แลว้ใส่ไฟล ์EA ท่ีโฟลเดอร์ MQL4 -> Experts ส่วนไฟล ์Indicator 
ใส่ไวท่ี้โฟลเดอร์ MQL4 -> Indicators 

2. คลิกปุ่ม Expert Advisors ใน Toolbar ใหเ้ป็นสีเขียวดงัรูป 

 

  

3. จะเห็นช่ือ EA ท่ีหวัขอ้ Expert Advisors ในหนา้ต่าง Navigator ดงัรูป ใหค้ลิกท่ีช่ือ EA แลว้ลากใส่ในกราฟ 

 

  

4. จะมีหนา้ต่างแสดงข้ึนมาเพื่อตั้งค่าดงัรูป 
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4.1) Only Long - ให ้EA เปิดออเดอร์ซ้ือเท่านั้น 

4.2) Only Short - ให ้EA เปิดออเดอร์ขายเท่านั้น 

4.3) Long & Short - ให ้EA เปิดออเดอร์ทั้งซ้ือและขาย 

4.4) Enable alerts - เปิด/ปิดการแจง้เตือน 

4.5) Disable alert once hit - ปิดการแจง้เตือนเม่ือมีการแจง้เตือนคร้ังแรกมาแลว้ 

4.6) Allow live trading - ให ้EA เปิดออเดอร์ในบญัชีเทรดจริงไดห้รือไม่  

4.7) Ask manual confirmation - ถา้ EA ตอ้งการเปิดออเดอร์ ใหเ้ราตอ้งท าการยนืยนัอีกหรือไม่  

4.8) Allow DLL imports - อนุญาตให ้EA มีการเรียกใช ้DLL หรือไม่ 

4.9) Confirm DLL function calls - ใหมี้การยนืยนัทุกคร้ังเม่ือมีการเรียกใชฟั้งกช์ัน่ใน DLL หรือไม่ 

4.10) Allow import of external experts - อนุญาตใหมี้การเรียกใชฟั้งกช์ัน่ใน EA ตวัอ่ืนหรือไม่ 
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โดยทัว่ไปก็จะต๊ิกท่ีช่อง 4.3), 4.4), 4.6), 4.8), 4.10) 

  

5) ท่ีแทบ็ Inputs ก็จะเป็นการเซตค่าพารามิเตอร์ต่างๆท่ีใชใ้น EA ซ่ึง EA แต่ละตวัก็จะมีการตั้งค่าท่ีแตกต่างกนั 

 

  

6) ถา้ติดตั้งเสร็จเรียบร้อยก็จะแสดงช่ือ EA และรูปหนา้ยิม้อยูด่า้นบนขวามือของกราฟดงัรูป 

 

  

* เด๋ียวรบกวนถา้ใครมีค าถามเพิ่มเติมใหเ้ขา้ไปโพสถามไดท่ี้ Wall เลยนะครับ ถา้โพสใน Note น้ีทาง Facebook 
จะไม่แจง้มาเตือนวา่มีคนโพสเขา้มาน่ะครับ ขอบคุณครับ 
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ขอใหร้ ่ ารวยทุกๆท่านครับ 

18/06/2557 

 

 


